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Software and Hardware Requirements for CiscoWorks Blue Maps

Software and Hardware Requirements for CiscoWorks Blue Maps

CiscoWorks Blue Maps imposes requirements on the workstation and the Cisco routers to be
managed.

Workstation Requirements
CiscoWorks Blue Maps can run on the following systems:

IBM RISC System/6000 workstation, Model 370 or 37T or higher (any with Power
Architecture), with AIX Version 3, Release 2.5, or Version 4, Release 1; plus NetView for AIX
Version 3.1 or 4.1

HP 9000 series with HP-UX A.09.05 and HP OpenView 3.3
Sun workstation with SunOS 4.1.3 (or 4.1.3_U1) and SunNet Manager Version 2.2

The network management systems listed here (NetView for AIX, HP OpenView, and SunNet
Manager) are optional but recommended.

All platforms require the following hardware and software:

Color monitor
PostScript-compatible printer (for printing window images)
CD-ROM drive on the host system, or CD-ROM drive on an accessible remote host

System software—X Window System Version 11, Release 5. On Sun workstations, the
windowing system can also be the Sun XNeWS server.

Hard disk space—5 MB in the root partition, 50 MB in her file system, plus 300 MB in the
file system where your Sybase database management system is installed

RAM size—192 MB minimum (256 MB recommended)

Swap space size—128 MB or more

To verify your workstation’s compliance with the requirements in this section, see Table 1.

Table 1  Hardware and Software Verification Methods

Verify on AIX on SunOS on HP-UX

Hard Disk Space df -I df -a bdf

OS Version oslevel uname -a uname -a

NMS Version Islpp -L $SNMHOME/bin/ Jusr/OV/bin/

nv6000.base.obj snm_version ovlicense

RAM Size Iscfg | grep mem dmesg | grep mem letc/dmesg | grep
Kbytes

Swap Space Size Isps -a pstat -s swapinfo

X Window System Ask your system administrator.

To create a file system, see thkfs, fsck, mkdir, andmount manual pages.
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Cisco I0S Configuration Requirements for CiscoWorks Blue Maps

Cisco Internetwork Operating System (Cisco I0S) Requirements

To be manageable by CiscoWorks Blue Maps applications, all routers must be running the
appropriate software version:

® For RSRB Maps—Cisco I0S Release 11.0 or above
® For DLSw Maps—Cisco IOS Release 11.1 (2.1) or above
® For APPN Maps—Cisco 10S Release 11.0 (5.3) or 11.1 (1.1) or above

Cisco I0S Configuration Requirements for CiscoWorks Blue Maps
Configure the Cisco I0S software in every managed router as follows:

snmp-server community string RO

string IS the read community string (a password for access to SNMP) in this router.
RO specifies read-only access to SNMP in this router.

For the RSRB Trap daemon (cwbrsrbtrapd) to perform optimally, all RSRB-enabled routers must
specify their addresses in the traps that they generate. Therefore, configure the Cisco I0S software
in every RSRB-enabled router as follows:

snmp-server trap-source interface

interface  specifies the router interface (such atokgl) whose IP address is used as the local
address for RSRB peering and stamped on the traps this router generates.

In addition, all RSRB-enabled routers must specify the Cigck¥\Blue Maps management host as
the destination of RSRB traps. Therefore, configure the Cisco |IOSasefitwwery RSRB-enabled
router as follows:

snmp-server host address string rsrb
address is the IP address of the management host, such as 123.45.678.90.
string IS the read community string for access to SNMP in the management host.

rstb  limits the traps sent taddress to RSRB-related traps.
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CiscoWorks Blue Maps Installation Procedures and Caveats

CiscoWorks Blue Maps Installation Procedures and Caveats

Installation, Configuration, and Deinstallation on AlX
See theCiscoWorks Blue Maps Installation Guide

Installation, Configuration, and Deinstallation on HP-UX and SunOS

Follow these steps to install and configure Maps on SunOS and HP-UX. The installation and
configuration processes take at least 30 minutes.

Step 1 If you are installing from a remote CDER drive, insert the CD-BM into the drve on a
remote system and export the CD-ROM file system (make it available to an outside
system). See “Exporting a CD-ROM File System from a SunOS or HP-UX System” and
“Mounting a Remotely Exported CD-ROM File System on a Local System.”

If you are installing from a local CD@®M drive, insert the CD-RM into the drve on the
local system, then mount the CD-ROM file system on the local system. See “Mounting a
Local CD-ROM on SunOS or HP-UX."

Step 2 Perform installation. See “Installing on SunOS and HP-UX."
Step 3 Perform configuration. See “Configuring Maps on SunOS or HP-UX."

Step 4 After successful configuration, remove log files. See “Removing Log Files on SunOS or
HP-UX."

for like systems. For example, the instructions are for exporting a CD-ROM file system from an
HP-UX system and mounting it on another HP-UX system for installation, and for exporting from

a SunOS system and mounting on SunOS, but not for cross-platform operation. If necessary, your
system administrator can help you with cross-platform exporting and mounting.

g Caution The instructions for mounting a remotely exported CD-ROM drive on a local system are

If it is necessary to reinstall a CiscoWorks Blue product, deinstall the existing software using
procedures in “Deinstalling on SunOS or HP-UX,” then reinstall as if it were a new installation.

To stop the SunOS or HP-UX installation or configuration procesy &ina@, press Break or Ctrl-C.

Exporting a CD-ROM File System from a SunOS or HP-UX System

The root thostsfile on the remote system must contain the host name of your local system and an
entry for the usemot. Otherwise, you cannot access the remote systemuvololad software from
its CD-ROM drive. For more information, refer to tti®sts manual page.

To export a CD-RM file system from a SunOS or HP-UX system, perform theviatig steps on
the remote system:

Step1 Place the CD-ROM in its caddy and insert it into the CD-ROM drive.
Step 2 Log in as the root user.
Step 3 Create dcdromdirectory, if one does not exist, by entering the following command:

# mkdir /cdrom

If the /cdromdirectory already exists, proceed to the next step.
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CiscoWorks Blue Maps Installation Procedures and Caveats

Step 4
Step 5

Step 6

Step 7

Step 8

Step 9

Create arfetc/exportdile using a text editor, if the file does not exist.

Edit the/etc/exportdile to include the following line:

/edrom -ro

If you just createdetc/exportgin Step 4), you must enable your workstation as an NFS
server. Start thefsdserver option by entering the following at the UNIX command line:

# letc/nfsd 8 &
# Jusr/etc/rpc.mountd -n

Mount the CD-ROM by entering the following command:

On SunOS:

# letc/mount -r -t hsfs /dev/ device_filename /cdrom
On HP-UX:

# letc/mount -o ro -t cdfs /dev/ device_filename /cdrom

In the SunOS command, threoption mounts the CD-ROM in read-only mode.
In the HP-UX command, th® ro option mounts the CD-ROM in read-only mode.

In each commandt indicates the type of file systeimsfsfor the ISO 9660 standard and
cdfsfor the High Sierra standard with Rock Ridge extensions.

In the SunOS command, replace tlewice_filenamegariable with/dev/srQ.

In the HP-UX command, replace tHevice_filenameariable with/dev/dsk/c201d2s@r
a different device number reported by fate/ioscanprogram for the CD-ROM device.

If the /etc/exportdile existed previously (before Step 4), enter the following command to
run exportfs:

# exportfs -va

If /etc/exportdid not exist previously, reboot your system.

# reboot

Step 10 Go to “Mounting a Remotely Exported CD-ROM File System on a Local System.”
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CiscoWorks Blue Maps Installation Procedures and Caveats

Mounting a Remotely Exported CD-ROM File System on a Local System

To mount a file system that is exported from a remote system, perform the following steps on the
local SunOS or HP-UX system:

Step1 Log in as the root user.

Step 2 Create dcdromdirectory, if one does not already exist, by entering the following
command:

# mkdir /cdrom

Step 3 To mount a file system that is exported from a remote system, enter the following at the
command prompt:

hostname# mount remote_hostname : remote_filesystem local_mount_point

For ekample, to mount th&edromfile system from a remote host calfadawayon a local
directory namedcdrom enter the following command at the prompt:

hostname# mount faraway:/cdrom /cdrom

The remote CD-ROM is ready for installation of software on the local system.
Step 4 Go to “Installing on SunOS and HP-UX.”

Mounting a Local CD-ROM on SunOS or HP-UX

To prepare the system for installation of software from a local CD-ROM drive, complete the
following steps:

Step1 Place the CD-ROM in its caddy and insert it into the CD-ROM drive.

Step 2 Log in as the root user.

Step 3 Create dcdromdirectory, if one does not exist, by entering the following command:
# mkdir /cdrom
If the /cdromdirectory already exists, proceed to the next step.

Step 4 Mount the CD-ROM by entering the following command:

On SunOS:

# mount -r -t hsfs /dev/ device_filename /cdrom

On HP-UX:

# letc/mount -o ro -t cdfs /dev/ device_filename /cdrom

In the SunOS command, theoption mounts the CD-ROM in read-only mode.
In the HP-UX command, th® ro option mounts the CD-ROM in read-only mode.

In each commandt indicates the type of file systemsfsfor the ISO 9660 standard and
cdfsfor the High Sierra standard with Rock Ridge extensions.

In the SunOS command, replace tlewice_filenamegariable with/dev/srQ.

In the HP-UX command, replace tevice_filenamegariable with/dev/dsk/c201d2s@r
a different device number reported by tat/ioscanprogram for the CD-ROM device.

Step5 Go to “Installing on SunOS and HP-UX.”
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CiscoWorks Blue Maps Installation Procedures and Caveats

Installing on SunOS and HP-UX
After the CD-ROM is mounted, use this procedure to move the software to the host system.

The default for each prompt is the value in brackets. To accept any default value, press Enter. Note
that you can press Break or Ctrl-C to stop the installation script at any time.

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6
Step 7

Step 8

Start the interactive installation and configuration script by entering the following
commands:

# cd /cdrom
# cwhbinstall

In response the the following prompt, enter the source of the software to be installed.

On SunOSs, predsnter to accept the default directory.

Source Directory :[/cdrom]

On HP-UX, enter the image file in which the software is stored.

Source File:[/cdrom/cwbmaps.tar]

In response the the following prompt, pr&sger. Do not override the default.

Where do you want to install the product :[/usr/cw-blue]

In response to the follting prompt, presEnter to accept a full installation of the RSRB,
DLSw, and APPN Map applications.

What filesets do you want to install : [CWBIC CWBLUE-RSRB CWBLUE-DLSW CWBLUE-APPN]

CWBIC is a fileset containing configuration scripts for each Map application, so always
install it. To install CiscoWorks Blue RSRB Map application only, type:

CWBIC CWBLUE-RSRB

To install the RSRB and DLSw Map applications, type:
CWBIC CWBLUE-RSRB CWBLUE-DLSW

The installation program reviews your responses to the previous questions and asks:
Do you wish to continue? (y/n)[y]:

PressEnter to continue, or typa and pres&nter to terminate installation.

The program installs the software from CD-ROM and reports on its progress.
Examine/tmp/update.lodor error messages by typing the following command:

On SunOSs, type:

# more /usr/cw-blue/log/cwb_install.log

On HP-UX, type:

# more /tmp/update.log

PressEnter to advance the display one screenful at a time.

Installation is complete. Go to “Configuring Maps on SunOS or HP-UX."

If it is necessary to deinstall any or all CiscoWorks Blue Maps applications, see “Deinstalling on
SunOS or HP-UX”

CiscoWorks Blue Maps 1.0 Release Note 7



CiscoWorks Blue Maps Installation Procedures and Caveats

Deinstalling on SunOS or HP-UX

If it is necessary to deinstall CiscoWorks Blue Maps, such as after a failed installation, follow this
procedure. Note that you can press Break or Ctrl-C to stop the deinstallation script at any time.

Step1 Log in as the root user and set the following environment variables: CWBROOT,
NMSROOT, SYBASE, DSQUERY, and DBNAME.

If you are using the K shell, type commands like the following:

# export CWBROOT=/usr/cw-blue

If you are using the C shell or the TC shell, type commands like the following:

# setenv CWBROOT /usr/cw-blue

Step 2 To start the interactive deinstallation script, type the following commands:

# cd /usr/cw-blue/install/bin
# cwbdeinstall

The deinstallation script lists the Maps filesets that are installed (plus the
CWBLUE-SNAVIEW dataset if CiscoWorks Blue SNA View is already installed).

Step 3 Pres$Enter to accept the default group of filesets to deinstall, or type an alternate set of
filesets and pregster. To deinstall the RSRB Map and APPN Map applications, tyyhe
the following:

CWBLUE-RSRB CWBLUE-APPN

The CiscoWorks Blue Maps database will be removed if you delete the CWBIC fileset.

Step 4 In response to the following prompt, pr&ger to begin the deinstallation of filesets, or
typen and press Enter to terminate deinstallation.

Do you wish to de-install? (y/n)[y]:

Step5 When the system prompt returns, examine the deinstallation log file. Unless you see an
error message in that file, deinstallation is complete.

On HP-UX, type:

# more /tmp/cwb_deinstall.log

On SunOSs, there is no deinstallation log file.

Step 6 Remove the deinstallation log file. On HP-UX, type:

# rm /tmp/cwb_deinstall.log

Step 7 Remove the home directory of tbeblueuser.

# rmdir /Jusers/cwblue

You can now reinstall the software.

8 CiscoWorks Blue Maps 1.0 Release Note



CiscoWorks Blue Maps Installation Procedures and Caveats

Configuring Maps on SunOS or HP-UX
Perform these steps on a SunOS or HP-UX system when installation of the software in complete.

The default for each prompt is the value in brackets. To accept any default value, press Enter. Note
that you can press Break or Ctrl-C to stop the configuration script at any time.

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Step 10
Step 11

Step 12
Step 13

On HP-UX only shut davn CiscoWrks and enter the folling commands to circunewnt
a bug:

# SYBASE/bin/isql -Usa -Psybasesa
1> shutdown with nowait
2> quit

To start the interactive configuration script, type the following commands:

# cd /usr/cw-blue/install/bin
# cwbconfigure

The following prompt appears only if the CWBROOT variable is not already set. Press
Enter to accept the default (the same directory in which you placed the software during
installation), or type an alternate directory name.

CiscoWorks Blue root directory: [/ust/cwblue]

In response the the following prompt, pr&sger to accept the default Sybase home
directory detected by the configuration program, or type another directory anf pesss
Sybase home directory: [fusr/nms/sybase]

In response the the following prompt, pr&sger to accept the Sybase server name
detected by the configuration program, or type another directory andgmtess

Sybase Server Name :[CW_SYBASE]

In response the the following prompt, type the Sybase system administrator’s password,
typically sybasesaand pres&nter.

Sybase sa password:

In response the the following prompt, pr&sger to accept the creation of a Sybase
database for CiscoWorks Blue Maps cali@di or type a diierent name and preEsiter.
CWBIlue database name :[SNA]

In response the the following prompt, pré&sger to accept the default database size of
250 Mb, or type another value and prEsser.

CWBIlue database size :[250]

The configuration program reviews your responses to the previous questions and asks:
Do you wish to continue? (y/n)[yl:

PressEnter to continue, or typa and pres&nter to terminate configuration.

The program performs the configuration and reports on its progress.

Unmount the CD-ROM by entering the following commands:

# cd/

# umount /cdrom

Eject the CD-ROM.

Configuration is complete. Go to “Removing Log Files on SunOS or HP-UX.”
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CiscoWorks Blue Maps Installation Procedures and Caveats

Removing Log Files on SunOS or HP-UX

During installation and configuration, messages are recorded in a log file to provide diagnostic
information in case a problem arises. Perform these commands on a SunOS or HP-UX system when
you are satisfied that configuration of the software is complete.

On SunOSs:

# rm /usr/cw-blue/log/cwb_install.log

On HP-UX:

# rm /tmp/update.log

Note Do notusem+log to remove the log files because the directory might contain other
applications’ log files that you do not want to remove.

Installation and Configuration Caveats

The caveats in this section apply to CiscoWorks Blue Maps on AlX, HP-UX, and SunOS
workstations.

Environment Variables

Table 2 lists the environment variables applicable to CiscoWorks Blue Maps on AlX, HP-UX, and
SunOS. This table supercedes the one on page 2-16Gistw/\érks Blue Maps Installation Guide

Table 2 CiscoWorks Blue Maps Environment Variables

Variable RSRB DLSw APPN Typical Value

CWBROOT yes yes yes lusr/cw-blue

NMSROOT yes yes yes /usr/nms

XAPPLRESDIR yes yes yes  $CWBROOT/Xdefaults

SYBASE yes yes On AIX: $NMSROOT/sybase10
On HP and SursNMSROOT/sybase

DSQUERY yes yes the name of the Sybase database server,
such aCW_SYBASE

HHHOME yes yes yes $NMSROOT/hyperhelp

HHPATH yes yes yes $NMSROOT/hyperhelp/bin

DBNAME yes yes If you specify any database name other

than the defult SNAduring configuration
of CiscoWorks Blue Maps, such as
SNA-2, you must set this variable
identically before starting a Map
application.

You Need Not Set AlIX Environment Variables Before Installation

You do not hee to set the efironment \ariables described in Step 3 of “Installing Ciscok¢ Blue
Maps Software Modules” in théiscoWorks Blue Maps Installation Guidéhe SMIT installation
process performs this step automatically.
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CiscoWorks Blue Maps Online Help and Documentation Caveats

You Must Set Environment Variables Before Deinstallation on Any Platform

Before deinstalling the Maps from any platform, you must set the following environment variables
by hand: CWBROOT, NMSROOT, SYBASE, DSQUERY, and DBNAME.

SMIT Screens in AlX 3.2.5 Are Not the Same As in AIX 4.1

TheCiscoVsrks Blue Maps Installation Guidkescribes installation of the product using the System
Management Interface Tool (SMIT) that is part of AlX 3.2.5. In AIX 4.1, the SMIT screens are
slightly different.

Do Not Click “Select All”

When you are using SMIT to install the CiscoWorks software from the CD-ROM onto the AIX
system, and you reach the Multi-Select List dialog on page 3-9 @fistkeWorks Blue Maps
Installation Guidefollow the instructions carefull{Click the indvidual object names that youawt

to install, but do not click th8elect All button at the bottom of the dialog window. T®elect Al
button activates a SMIT/AIX software bug.

Administrator Must Assign Password to cwblue User
When installation is complete, the user must assign a passwordctelthueuser.

CiscoWorks Blue Maps Online Help and Documentation Caveats

The following errata have been discovered inGszoWorks Blue Maps Installation Guidad
online help system.

® No online help is available for the seed file onAldenin> Discover window.
® When you request online help for tBdit> Modify Device, you see help fdedit> Add Device.

® In the DLSw Map application, the Help button for the Information view and for the Statistics
view incorrectly brings up help entitled\bout DLSwW. At the “About DLSw” help panel, click
the Browse button until you see the text you need.

® If the online help systenver issues an error such aséhkffing ! Bad Macrdjgnore the message
and click theOK button. The correct help panel will appear.

® Inthe APPN Map application, the Help button onVew> Locate window does not work.
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CiscoWorks Blue Maps Operational Tips and Caveats

The tips and ozeats in this section apply to all Ciscokés Blue Maps application on all platforms
unless otherwise noted.

Set the CWBROOT Variable before Starting the NMS

To run any Map application from an NMS menu, you must have set the CWBROOT environment
variable before starting the NMS.

If you are using the K shell, type the following on the command line:

# export CWBROOT=/usr/cw-blue

If you are using the C shell or the TC shell, type the following on the command line:
# setenv CWBROOT /usr/cw-blue

Launching Map Applications from SunNet Manager

To launch a CiscoWorks Blue Maps application from SunNet Manager, you must have started
SunNet Manager with the thieoption. For example:

# snm -i

Unimplemented Features
The following features (described in both the installation guide and online help) are not implemented
in any Map application:
® File> Print
® Admin> Show Key

® View> See All

Running Path Tool from the Tools Menu of Any Map Application

Only a member of the CiscaMks group can select anxeeuteTools> Rath Tool. The de&ult name
of the CiscoWorks group (set during configuration of the prerequisite CiscoWorks product) is
cscworks

Modifying Color Schemes for Map Applications

After installation, you can modify the color scheme of the Map applications by copying any
Color. schemenamgle in thesCWBROOT/Xdefaults directory to the file named
$CWBROOT/Xdefaults/Color . For example:

$ cd SCWBROOT/Xdefaults
$ cp Color.Rembrandt Color

A new color scheme takes effect the next time you start a Map application (but does not affect the
CiscoWorks Blue SNA View product).
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Discovering Devices From the SunNet Manager Database

UsingAdmin> Discover to launch disceery of devices knan to the SunNet Manager database is
time consuming because all devices in that database are queried. [CSCdi48739]

Discovering Devices From a Seed File

Using Admin> Discover to launch discovery of devices listed in a seed file, the default read
community string ipublic. If the read community string of your routers is poblic, type each
router's read community string into the seed file. [CSCdi52040]

When the Application Is Busy During Screen Update

The user is sometimes prevented from using the application because it is busy handling screen
updates. The updates also affect views that do not require updates (no objects on the view have
changed state). [CSCdi52042]

In information dialog boxes like Virtual Ring Info and the Locator window, the user is not notified
the interface is busy by means of a busy cursor. [CSCdi52044]

If RSRB Peer Info Fails

If Peer Info fails in the RSRB Map application, the dialog box appears with all values set to zero.
[CSCdi52047]

RSRB Virtual Rings
If multiple virtual rings are configured on the router:

® Peerinformation is not always reported by the RSRB Map application correctly. [CSCdi52052]

® The RSRB Map application’s Virtual Ring view displays real rings whether they are associated
with the target virtual ring or another virtual ring. [CSCdi52055]

Physical Units Associated with DLSw Appear on RSRB Map

In routers that have both RSRB and DLSw configured, the RSRB Map application cannot
distinguish between virtual rings/PUs that are associated with DLSw and those associated with
RSRB. Both are drawn. [CSCdi52056]

Shortcomings of Edit> Modify

If no device is selected on the mdggit> Modify prompts you for a déce name. If the déce name
you specify is in the database, but not drawn on the map, you cannot select, create, or modify it.
[CSCdi52057]

If you useEdit> Modify to modify a deice (to correct a community name, faaenple) it is markd
as undiscovered and will not be picked up by the polling process. The user should “discover” that
device individually or wait for the discover daemon (if running) to discover it. [CSCdi52049]

RSRB and DLSw Daemon Troubles
The user is not warned if the Monitor or Poller daemons fail or are stopped. [CSCdi52074]

When a daemon terminates abnormally,Akenin> Process Contl window still reports it as
running. [CSCdi49334]
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Layout and Window Drawing Caveats

If you modify the layout of a vig, either by meing an object or by selecting a layout other than the
default, you must save that layout wittle> Savebefore changing views if you intend to see the
modified view again. [CSCdi52079]

Routers, links, and rings are occasionallyadran top of one anothdn particulayif there are three
objects in a view, some of the links may overlap completely. [CSCdi50367 and CSCdi50221]

When a lage number of objects are being added to the screen, the objects are all placed in the upper
left hand corner of the view before being laid out. This process can take minutes. [CSCdi52041]

If a view appears blankut the Locator winde is not blank, use the Locator to bring the objects into
the view.

On HP-UX only,Layout> Zoom In andLayout> Zoom Out do not work.

Do Not Press CapsLock or NumLock

If the CapsLock or NumLockeys on the kyboard are pressed (set), the mouse and mausmb
do not work on map objects. [CSCdi52080]

Problems with the Locator Window

If you create a new window or clone one, and then yoWpsen> Show Locator to activate the
Locator and then you close the windahe Locator remainaibis inoperatie. Attempts to use this
locator window results in the application crashing. Opgion> Show Locator to deactivate the
Locator without trying to use or move it. [CSCdi52092]

View> Locate Can Fail to Show a Located APPN Device

Opening Map Files

If you use APPN'&View> Locatetool when the Locator window is deactivated (by use of
Option> Shav Locator), the target deéce will be highlighted if found &t you might hae to scroll
horizontally or vertically to bring it into view.

If you use APPN'&/iew> Locatetool when the Locator window is operating (by use of
Option> Shav Locator), the taget deice will be highlighted if found it you might hge move the
Locator box to bring it into view on the map window.

All Map applicationsdil if you open a map file not created by the same application. [CSCdi49680]

Using dbutil to Check the Transaction Log

Periodically use thdbutil program to verify that the transaction log does not exceed 20% of the
“CW Blue Database Size” you configured during installation.

Thedbutil program does not work on HP-UX.

DLSw Map Application Reports Some Statistics as 0

The DLSw Map application reports some statistics asith &\future release of the Cisco 10S, the
DLSw Map application will yield more complete statistics.
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Troubleshooting CiscoWorks Blue Maps

Don’t Run RSRB and DLSw Maps Simultaneously
The RSRB and DLSw Map applications can create a database contention problem.

Don't Use Edit> Rediscover on HP-UX
On HP-UX, theEdit> Rediscovermenu item causes the RSRB and DLSw Map applications to fail.

Multiple Instances of a Map Application Are Possible
To have more than one instance of any Map application, start each instance under a different user
name.

Routers With Multiple IP Addresses
A router with multiple IP addresses might appear on a map as multiple routers.

If you list the multiple IP addresses of one router in the seed file, the router will appear multiple times
on the map.

Format Seed Files Correctly
An incorrectly formatted seed file can causgldiap application todil. Extraneous space characters
at the end of a line are one culprit.

Troubleshooting CiscoWorks Blue Maps

This section describes how to detect and correct problems with a Map application. It replaces the
“Troubleshooting Ciscodrks Blue Maps” chapter in tligiscoVérks Blue Maps Installation Guide

Troubleshooting the RSRB and DLSw Map Applications
If the RSRB or DLSw Map applications fail to operate correctly, perform each of the following
diagnostic procedures as the root user:

Step 1 Intherunrsrb orrundisw script, verify that the environment variables are set according
to the table in the “Installing CiscoWorks Blue Maps” chapter ofaiseoWorks Blue
Maps Installation Guide

Step 2 Verify that the Sybase dataserver that you named during installation is active by using the
showservercommand in th&SYBASE/installirectory.

Step 3 Use thedbutil command in théCWBROOT/etdirectory to verify that the database
transaction log space is at least 20 percent the size of the database.
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If the problem has not been resolved, a daemon might have failed. Consider the following
possibilities.

® |f the RSRB or DLSw map is blank, synchronization with the network management system
(NMS) or seedfile may la failed. Male sure that netark devices haw been disagered by the
NMS and usé@dmin> Process Controlto reset the Sync daemon. Note that SunNet Manager
maintains a separate device database for each user. You have to use the RSRB or DLSw Map
application as the user whose database you want to synchronize.

® |f a device fails to appear on the Map, the Discover daemon may have failed. Perform the
following steps:

— Enter the following commands to verify the devicehtry in the Sybasievicedable. This
example is for a database nangNA

$ SYBASE/bin/isql -Usa -Psybasesa

1> use SNA

2> go

3> select count(*) from snasuper.devices
4> go

If the reported count is zero, tdevicedable is empty.

If the table is not empty, use the following commands to see if the device’s entry is in the
devicedable.

5> select device_name from snasuper.devices
6> go
7> quit

If the device is not in thdevicedable, check for its existence in the NMS database. If the
device is in thedevicegable, \erify that the deice is running the correct release of the Cisco
I0S, and that you can ping the device from the NMS. Alsdcdlit Modify to verify that

its read community string is correct.

— UseEdit> Add Deviceto add the ddce to the map. The application attempts to disca
newly added device automatically.

® |f a device appears on the map but the information about it appears to be out of date, the Poller
or Monitor daemons may e failed. Use thelbutil command in th€ CWBROOT/etdirectory
to verify that:

— All Sybase triggers and stored procedures are in place.

— The transaction log file does not exceed 20% of the “CW Blue Database Size” that you set
during configuration. If the transaction log is togkgruse the follwing commands to dump
it:
$ SYBASE/bin/isgl -Usa -Psybasesa
1> dump tran SNA with NO_LOG
2> go
3> quit

Then use thebutil command in th&éCWBROOT/etdirectory to verify that the database
transaction log is smaller.

If the problem still has not been resolved, see “Running Daemons in Debug Mode.”
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Running Daemons in Debug Mode

You can restart any or all suspect daemons in the debug mode (withajpion detailed in the
“CiscoWorks Blue Maps Daemons” appendix of @iscoWorks Blue Maps Installation Gu)de

read their output ostdout and report your observations to the TAC if necessary. If you restart the
Monitor daemon with thec option, you must restart the RSRB, DLRwAPPN Map applications.

On startup, ¥ery daemon checks for a running instance of itself. If you restadaemon with the
-f or -s option, an existing instance is automatically killed. Withdwlr -s, the existing instance
survives and a new instance does not start.

For a list of running RSRB and DLSw daemons and their process identification numbers, use the
cwbdaemonsitility in the SCWBROOT/etdirectory.

RSRB and DLSw Error Messages
These error messages are shared by the RSRB Map and DLSw Map applications.

Error Message

Discovery failed.

Explanation The application failed to query network devices.

Recommended Action  On HP-UX and AlX, uséusr/OV/bin/ovstatuso verify that the HP
OpenView daemons are running.

Error Message

No response from update server.

Explanation ~The monitor daemon is not running.

Recommended Action  UseAdmin> Process Controlto start or reset the Monitor daemon.

Error Message

device_name already exists.

Explanation Edit> Add detected that the diee you specified already has an entry in the database.
Recommended Action  If you receive this message in error, log in to the Sybase database and

delete the entry for device in the Devices table.

Error Message
device_name no such device.
device_name failed to add.

Explanation Thedevice_name isot known to the operating system or the domain name server.

Recommended Action  Check to see whether the domain name server has been configured.
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Error Message
daemon_name is already active.

Explanation A copy of daemon_name is already running.

Recommended Action  Select theResetbutton in the Process Control window.

Error Message
Rediscover Device(s) failed.

Explanation The SNMP query to a device was not successful. Either the device is no longer
reachable from the management station or it is not responding to the SNMP query.

Recommended Action  Ping the router. Telnet to the router and check the configuration.

Error Message
Cannot log into the database.

Explanation Application either cannot get to the data server or cannot log in.

Recommended Action  Check the environment variables, try to log in to the dataserver from a
separate window, and check the transaction log. Then try to restart the application.

Error Message
Database initialization failure

Explanation Failure to connect to the NMS database before discovery.

Recommended Action  Verify integrity of the network management processes by running the
OVstatus command in théusr/OV/bindirectory.

Troubleshooting the APPN Map Application
This section presents scenarios and troubleshooting techniques for the APPN Map application.

® If the global map is blank, the problem could be that:

You specified an incorrect IP address or read community string in the startup dialog.
The IP path to the network topology agent is down or degraded.

The IP address and read community string you specified is not of an APPN network node,
or APPN is not started in that node.

To resolve this problem, perform one or more of the following:

UseAdmin> Discover All.

Verify operation of the netwrk topology agent by pinging it, or usatR Tool to verify it is
accessible.

Use telnet to access the agent and start the APPN protocol.
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® |fthe status of all neterk nodes is unknen to the application, the netnk topology agent could
have &iled or APPN could hee been stopped in thatuiee. Ping the netark topology agent or
use Path Tool to verify it is still accessible. If necessary, use telnet to access the agent and start
the APPN protocol.

® |faknownn LU cannot be found by the application, perform Get Directory for additionabrietw
nodes. When you ka collected the directory from enough netlwnodes, the LU can be found.

® If a known link station does not appear in the List TGs and Links window, close the window,
perform Get Local Topology for the node at which the link is defined, and reopen the List TGs
and Links windav to see that the link is listed. Alternatly, set theautolocaltopovariable in the
appninitfile to ALL or NN_ONLY and restart the application.

® |f a known good connection appears degraded (yellow), a defunct transmission group number
may exist in the network topology agent’s database. In a number of days, the network topology
agent will delete the defunct number. When you start the APPN Map application after that
deletion occurs, the connection does not appear degraded.

® |f the status of a port, link, or endpoint transmission group is reported incorrectly, perform Get
Local Topology for the owning node. Alternatively, automate the Get Local Topology function
by setting theutolocaltopovariable in theappninitfile to something other than NONE and the
loctopopollvariable to a desired setting, then restart the application.

APPN Map Error Messages
These error messages are unique to the APPN Map application.

Error Message
Device name & read community required

Explanation The application must send an SNMP MIB request to a node, but no device name is
known for this node.

Recommended Action  If the displayed default is not correct, enter the device name and read
community string. Wur input also sets the @efit for future SNMP MIB requests. If you dokhow
the device name or the node cannot be an SNMP agent, click Cancel to terminate the request.

Error Message
Startup input required

Explanation The startup dialog is being displayed because the application has not yet accessed a
network topology agent. If a valid CP Name has been selected, it may require a device name to be
filled in.

Recommended Action  Select a valid CP Name or device name, or discover a network topology

agent. To preent this dialog from being stum in the future, specify an agent in tqgpninitfile or
as an option to theinappn command.
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Error Message
View may be incomplete

Explanation An Adjacent Nodes vig is being shan for a node that does notedocal topology
information available. Only adjacent nodes learned from the global view or from local topology
collection from other nodes are displayed. Adjacent end nodes and LEN nodes areetyastik
shown.

Recommended Action  If this node can act as an agent and yowkit®|P address, or diee name
and read community string, collect its local topology now.

Error Message
View could not be retrieved

Explanation A view requires data that is not available to the application. Most commonly this is
the Ports and Links view, and local topology is not available from the target node.

Recommended Action  If this node can act as an agent and yowkit®|P address, or diee name
and read community string, collect its local topology now.

Error Message
Will retry by polling

Explanation A network topology agent has been selected, but is not returning network topology
information. No global map is currently available. The application will retry this agent at the
network topology polling rate.

Recommended Action ~ Perform the following steps in order. Stop when one is successful.

Step1 You may selecAdmin> Discovery to discover a new network topology agent.

Step 2 Ensure the selected agent is an APPN network node with the APPN MIB, and that the IP
address or déce name you specified is correct. If not, stop the application and restart with
a new network topology agent.

Step 3 Ensure that the APPN protocol is active on the target agent.

Step 4 Ping the agent to see if it is alive and a path to it is available.

Error Message
Database initialization failure

Explanation Failure to connect to the NMS database before discovery.

Recommended Action  Verify integrity of the network management processes by running the
OVstatus command in théusr/OV/bindirectory.
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Error Message
No APPN NNs discovered

Explanation Discovery was completed but a network topology agent was not found.

Recommended Action  Review the déces in the seedfile or NMS database to ensure that at least
one active APPN network node exists. ThenAdmin> Discover to retry, or exit the application
and restart it and specify a known-good network topology agent in the startup dialog.

Error Message
No devices discovered

Explanation There were no devices available to be discovered.

Recommended Action  Review the device list in the seedfile or NMS database so that discovery
has a chance of success. ThenAgmin> Discover to retry, or exit the application and restart it
and specify a known-good network topology agent in the startup dialog.

Cisco Connection Online

Cisco Connection Online (CCO), formerly Cisco Information Online (CIO), is Cisco Systems’
primary, real-time support channel. Maintenance customers and partners can self-register on CCO
to obtain additional content and services.

Available 24 hours a day, 7 days a week, CCO provides a wealth of standard and value-added
services to Cisco’s customers and business partners. CCO services include product information,
software updates, release notes, technical tips, the Bug Navigator, configuration notes, brochures,
descriptions of service offerings, and download access to public and authorized files.

CCO serves a wide variety of users through two interfaces that are updated and enhanced
simultaneously—a charactbased ersion and a multimediavsion that resides on theovitl Wide

Web (WWW). The charactdrased CCO supports Zmodenerkhit, Xmodem, FTRnternet e-mail,

and fax download options, and is excellent for quick access to information over lower bandwidths.
The WWW version of CCO provides richly formatted documents with photographs, figures,
graphics, and video, as well as hyperlinks to related information.

You can access CCO in the following ways:
®* WWW: http://www.cisco.com.
® Telnet: cco.cisco.com.

® Modem: From North Americat08 526-8070; from Europ83 1 64 46 40 82. Use the
following terminal settings: VT100 emulation; databits: 8; parity: none; stop bits: 1; and baud
rates up to 14.4 kbps.

For a copy of CCO’s Frequently Asked Questions (FAQ), contackelp@cisco.com. For
additional information, contactco-team@cisco.com.

Note If you are a network administrator and need personal technical assistance with a Cisco
product that is under warranty or covered by a maintenance contract, contact Cisco’s Technical
Assistance Center (TAC) at 800 553-2447, 408 526-7208s@tisco.com.  To obtain general
information about Cisco Systems, Cisco products, or upgrades, contact 800 553-6387,

408 526-7208, ots-rep@cisco.com.

CiscoWorks Blue Maps 1.0 Release Note 21



22 CiscoWorks Blue Maps 1.0 Release Note



